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Pharmacokinetic Case Study Cadralazine Kinetics 

 
Cadralazine Kinetics: A One-Compartment Model 

 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 

• How to create a one-compartment model using the model building tools. 
• How to create a bolus experiment on the model using the experiment building 

tools where the amount of the dose is entered in the data file. 
• How to enter (working with) data. 
• How to create experimental samples and associate them with data. 
• How to write the noncompartmental parameters. 
• How to obtain initial parameter estimates for your model parameters. 
• How to solve your model and view the solution. 
• How to fit your model to your data, and view the statistical information associated 

with the “Fit,” including derived variables (noncompartmental parameters). 
• How to use Notes to keep track of your modeling work. 
• How to define alternative one-compartment model parameterizations. 

 
Data Required 
 

The data file for this case study is 
 

cadralazine.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
This case study will reinforce how you perform the basic operations in the SAAM II 
Compartmental application.  
 
The model used in this case study was developed to describe cadralazine pharmaco-
kinetics based on analysis of plasma concentrations that were measured after injecting an 
intravenous (iv) dose of this drug. Cadralazine is an antihypertensive drug that acts as a 
peripheral arteriolar vasodilator.1 It is chemically similar to hydralazine except that it has 
a protected hydrazine group. As a result, it does not appear to cause the systemic lupus 
erythematosus-like syndrome that occurs in some patients who are treated with 
hydralazine. 
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Cadralazine dosing is normally by the oral route in amounts of 15 to 30 mg daily, often in 
combination with other drugs. Cadralazine is metabolized to a small extent in the liver 
with most being excreted in the urine. The plasma half-life is 0.8 to 3.2 hours. 
 
The data for this case study were taken from Wakefield et al.2 This is a theoretical paper 
in which population modeling techniques are discussed. Cadralazine was used as an 
example because the drug decays monoexponentially following an iv injection. The 
experiment performed was to inject a single dose of 30 mg into each subject, and to take 
serial samples from plasma at various times. Wakefield et al. reported results from ten 
patients and we will use the data from one patient in this case study. 
 

1. McTavish, D., Young, R.A., Clissold, S.P. “Cadralazine. A review of its 
pharmacodynamic and pharmacokinetic properties, and therapeutic potential in 
the treatment of hypertension.” Drugs 1990; 40:543-60. 

 
2. Wakefield, J.C., Smith, A. F. M., Racine-Poon, A., Gelfand, A. E. “Bayesian 

analysis of linear and non-linear population models by using the Gibbs Sampler.” 
App Statist 1994;43:201-21. 

 
Part 1.  Create a one-compartment model using the SAAM II Compartmental 

application. 
 
This part of the case study will show you how to create the following one-compartment 
model in the SAAM II Compartmental application: 
 

 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open as follows: 
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2. Create a one-compartment model. 

 
a. In the SAAM II Toolbox, click Model. 

 
b. In the SAAM II Toolbox, click Compartment (this tool is now available). 
 
c. Click on the Drawing Canvas approximately where you would like the 

compartment to be located. Notice as you move the cursor on the Drawing 
Canvas that the cursor has a small compartment associated with it to indicate 
that the Compartment tool is available. A compartment with the number 1 
will appear on the drawing canvas.  

 
d. Double-click Compartment 1 to open the Compartment Attributes dialog 

box. 
 

e. Type “cadralazine” in the Reference Name box. The Compartment 
Attributes box will appear as follows: 
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f. Click Done. 
 

3. Construct a loss from Compartment 1. 
 

a. In the SAAM II Toolbox, click Flux. 
 
b. Click on Compartment 1, and then click anywhere on the Drawing Canvas. 

 
c. This will create a loss, k(0,1), from Compartment 1. No matter where you 

click on the drawing canvas, the loss will always point down. 
 

Your Drawing Canvas will appear (in part) as shown below: 
 

 
 

At this point, you have successfully created a one-compartment model with a single loss 
from Compartment 1. Now you need to reproduce the experiment performed in the 
laboratory on this model. 
 
Part 2. Create the pharmacokinetic experiment on the model. 
 

1. Create the experiment. 
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a. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 
unavailable and the Experiment tools are available. The Experiment 
Attributes dialog box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours.” 
 
c. Enter “24” in the End at box. The Experiment Attributes dialog box will 

appear as follows: 
 

 
 

d. Click Done.  
 

The Create Experiment dialog box will appear on the Drawing Canvas. The 
choice of experiment Types is an Experiment or a System. Experiment is 
selected with the name “Exper”. Replace “Exper” with “Cadralazine” by typing 
“Cadralazine” in the New Name box. The Create Experiment dialog box will 
appear as follows: 

 

 
 

e. Click Create. 
 
 

  Experiment vs. System. The Create Experiment dialog box is where you 
create your experiment. There are two types of experiments - “Experiment” 
and “System”. 
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The Experiment type will invoke SAAM II’s differential equation machinery. 
When you create this type of experiment, your compartmental model will be 
interpreted by SAAM II as a system of differential equations. Once parameter 
values and inputs have been specified, SAAM II can Solve the system of 
differential equations, and can Fit your model to your data. This type of 
experiment is designed to deal with time dependent data following an 
experimental (exogenous) input into the system.  
 
The System experiment creates a system of algebraic equations whose 
coefficients are the k(i,j) of your compartmental model. The System model is 
used primarily in tracer-tracee experiments to describe the tracee data in the 
steady-state. 
 

 The default New Name is “Exper”. This can be changed to a name of your 
choice. The name you enter will appear just below Experiment in the SAAM 
II Toolbox as shown below. 

 

 
 

 
2. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
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b. In the File menu, click Open. The file cadralazine.dat should appear in the 
list (if it does not, find the folder where you put this data file). 

 
c. Double-click cadralazine.dat. The data in this file will appear in the Data 

window as follows: 
 

 
 

  Entering constants in a Data file. You will notice in the data file, following 
the END statement, the line “CONST Dose 30”. You can enter constants in 
your model such as doses, weights, heights, etc. using the CONST operator. 
Constants, so designated, must lie outside a data stream, i.e. streams between 
DATA and END. This particular case will be used to illustrate experimental 
inputs defined using constants thus making it convenient to store this 
information in several study files. 

 
 

  Entering comments in a Data file. You can enter comments in your data file if 
you precede each line with “#.” In this data file, comments are provided which 
explain where the data came from. In addition, the equations for the 
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noncompartmental parameters are entered as comments. This is for 
convenience; later in the case study, these will be pasted into the Equations 
window. 

 
 

d. Close the Data window. 
 

3. View your data using a line plot. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. 
 

b. Be sure the List All Variables check box is selected. (Click this box if it is 
not selected). 

 
c. Click plasma to move it to the Current Selection pane. 

 
d. Click Done. A plot of the data will appear in the Plot window. 

 
e. In the View menu, click Line Plot. 

 
f. In the View menu, click Semilog. Your plot will appear as follows: 
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g. Close the Plot window. 
 

  Line Plots. The data can be viewed as a linear or semilog plot after they have 
been loaded into the SAAM II Data window. When plotted as a semilog plot, 
they can help you decide how many exponentials (compartments) will be 
needed for the model. In this case, because the data appear as a straight line in 
a semilog plot, it is clear that a single compartment will be sufficient. 

 
 

4. Add the appropriate experimental input to the model. In this subject, a bolus input 
of 30 mg of cadralazine was administered intravenously. 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. An input 

arrow, ex1, will appear on the drawing canvas pointing to Compartment q1. 
 

c. Double-click ex1. The Exogenous Input dialog box will open. 
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d. In the Input Type pane, select Equation. 
 
e. In the Equation box, type “ex1=Dose”. 

 
f. In the Event Start box, enter “0”. 
 
g. In the Event Stop box, enter “0”.  
 
h. Click Add. The model with the Exogenous Input dialog box will appear on 

the Drawing Canvas as follows: 
 

 
 
i. Click Done. 

 

  Specifying a bolus injection using an equation. Remember you have entered 
information on the amount of the bolus injection as a constant in your data 
file. To specify this as a bolus in the Exogenous Input dialog box, you write 
the information in equation format. This is what links “Dose” with ex1. Since 
the dose is administered as a bolus, the event start and stop times are zero. 
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5. Create a sample. This sample represents the measurements you collected in your 

actual experiment. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. 

 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. In the Associate with Data Name box, type “plasma”. 
 
e. In the Equations box, edit the sample equation “s1=q1” to read “s1=q1/V1”. 

The Sample Attributes dialog box will appear as shown below: 
 

 
 
f. Click Done. 

 
6. View the Event Line. 
 
 It is useful to have a visual representation of your experiment in terms of when 

experimental inputs were done, and when samples were taken. This can be 
observed using the Event Line. 

 
a. In the Show menu, click Event Line. The Event Line will appear as follows: 
 

 
 

©University of Washington Cad - 11 Rev. 08/10/01 



Pharmacokinetic Case Study Cadralazine Kinetics 

 The Event Line shows both the times of the test input(s) and samples. In 
general, you can leave the Event Line open if you wish. 

 
b. Close the Event Line. 

 
Part 3. Defining Derived Variables (Noncompartmental parameters). 
 
The parameters for your model are the rate constant k(0,1) and the volume V1. The rate 
constant k(0,1) is a fractional measure of the elimination rate of the drug, and it has units 
of inverse time (in this case, 1/hour).  
 
Usually, it is of interest to calculate the elimination clearance of a drug. This is defined, 
for a one-compartment model, as the product of the elimination rate constant and the 
distribution volume of the compartment. In other words 
 

Cl = k(0,1) * V1 
 
In the language of SAAM II, clearance Cl is called a derived variable as it is a function of 
the model parameters k(0,1) and V1. As you recall, parameters are variables that appear 
in the equations characterizing the model or experiment, but were not given numerical 
values. SAAM II automatically determines the model parameters. In addition, SAAM II 
can calculate values for functions of the model parameters. These are called derived 
variables. Following a successful “Fit,” both appear in the Statistics window in the 
Parameter/Variable pane. 
 
Besides clearance, there are a number of other noncompartmental pharmacokinetic 
parameters that can be estimated using the one-compartment model. These are 
 

Cl=k(0,1)*V1 
Cmax = Dose/V1 
t_half = log(2)/k(0,1) 
AUC = Dose/(V1*k(0,1)) 
AUMC = Dose/(V1*k(0,1)*k(0,1)) 
MRT_syst = AUMC/AUC 
MRT_plasma=1/k(0,1) 
Vss = Cl*MRT_syst 

 
Notice that in this list there are two mean residence times. One is the system mean 
residence time (MRT_syst); this is the average time a drug particle remains in the system 
before being irreversibly lost. The other is the plasma mean residence time 
(MRT_plasma). This is the average time the drug stays in plasma before being 
irreversibly lost. Since this is a one-compartment model, the two are the same. 
 
You can enter these parameters directly. For convenience, they can be cut and pasted 
from the Data file to the Equations dialog box as described below: 
 

©University of Washington Cad - 12 Rev. 08/10/01 



Pharmacokinetic Case Study Cadralazine Kinetics 

1. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
2. Select and copy the equations for the noncompartmental parameters. The selected 

information will appear in the Data window as follows: 
 

 
 
3. Close the Data window. 
 
4. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 

click Equations . The Equations dialog box will open. 
 
5. Paste the equations in the Equations Defined Here pane in the Equations dialog 

box. 
 
6. Remove the “#” from the beginning of each equation. The Equations dialog box 

will appear as follows: 
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  Equation syntax. There are two points to remember about equation syntax in 
SAAM II. First, while it may be appealing to define half-life (half-life and 
half-time can be used interchangeably) as t_1/2, this is improper syntax, and 
SAAM II will display an error message. The other point is that the natural log 
is “log,” not “ln.” If you define, for example, t_half=ln(2)/k(0,2), “ln(2)” will 
be interpreted as a parameter instead of an algebraic operation, and appear as a 
parameter in the Parameters dialog box. 

 
 

7. To view the differential equation generated by SAAM II, in the View menu, click 
Diff. Eq. The Equations dialog box will appear as follows: 
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8. Close the Equations dialog box. 

 
Part 4. Obtain and enter the parameter values  
 
Before you can Solve (simulate) your model or Fit your model to your data, you must 
provide numerical estimates for the parameters of your model. These are the parameters 
that appear in the Parameters dialog box. 
 
The parameters for your model are the rate constant k(0,1) and the volume V1. 
 

1. Enter parameter values. 
 

 Initial parameter estimates. How the initial estimates for the parameters k(0,1) 
and V1 were obtained is explained in the appendix for this case study. Initial 
estimates for both the iv bolus and iv constant infusion into the single 
compartment model are discussed. How the estimates are obtained applies to 
any experiment in which you are using a single compartment, or 
monoexponential model to analyze data following an iv bolus or constant 
infusion. 
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a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 

If k(0,1) is not selected, double-click k(0,1) to select it. Be sure the 
Adjustable option is selected. 

 
b. Enter “0.2” in the Value box, and click Save. 

 
The current value of k(0,1) will appear as “0.2;” the low and high limits will 
automatically be set equal to “0.02” and “2.0” respectively. 

 
c. Double-click V1 to select it. 
 
d. Enter “17” in the Value box, and click Save. Your Parameters dialog box 

should appear as follows: 
 

 
 

e. Click Done. 
 
Part 5. Solve the model, fit the model to the data, and view the solution. 

 
1. Solve your model. 

 
In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, 

click Solve . 
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2. View the solution to your model using Quick Plot. 
 

a. Click s1 on your model to select it. 
 
b. In the View menu, click Quick Plot, or alternatively press Ctrl and M 

simultaneously. The following plot will appear on in the Quick Plot window. 
Notice the scale is linear. 

 

 
 

c. To view this plot with a semilog scale, in the View menu, click Semilog. The 
following plot will appear as follows: 
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d. Close the Quick Plot window. 
 

3. View the solution to your model using the Plot command. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . If the Plot window opens with a previous plot, in the Set 
menu, click Plot/Table Variables to open the Plot and Table Variables 
dialog box. If this dialog box does not open as follows, check the List All 
Variables check box: 
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You can now choose from the different variables for the Y-Axis for your plot. 
 
b. In the Plot and Table Variables dialog box, clear the List All Variables 

check box to list only those variables associated with data. 
 
c. While depressing the Control key on your computer click s1 and plasma. 

Both variables will move to the Current Selection pane. 
 
d. Click Done. A plot similar to your Quick Plot will appear. If it is not in semi-

log mode, in the View menu, click Semilog. 
 

4. Change the labels on your plot. 
 

a. In the Set menu, click Plot Labels. The Plot Labels dialog box will open. 
 
b. Type “Cadralazine Concentration” as the title of the plot in the Title box. 

 
c. Type “mg/L” as the label for the Y-axis label in the Y Axis box. (The 

concentration data are in units of mg/L). The Plot Labels dialog box will 
appear as follows: 
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d. Click Done. The plot will appear as shown below: 

 

 
 

5. With the Plot window open, fit the model to the data, view the solution, and 
record the results. 

 
a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . 
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During a “Fit,” a Fit Status message will appear (on a fast computer, you may 
just see a flash). This is the counterpart to the Solution Status message you 
saw when you solved your model originally. The Fitting Status bar gives you 
information both on the integration part of the “Fitting,” and on the iterations. 
You can abort the “Fit” by clicking Abort. 

 
When you have fitted your model to your data, your Drawing Canvas with 
the Plot window should appear (after moving the Plot window) as follows: 

 

 
 

It is interesting that there are no data between 10 and 24 hours. This is typical 
of many pharmacokinetic studies because the staff leaves in the evening. Thus 
the 10-hour sample is taken just before they leave, and the 24-hour sample 
taken when they arrive in the morning.  

 
b. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . 
 

You can view the statistics separately, or have them appear on the Drawing 
Canvas along with the rest of the information (this may require moving some of 
the open windows.) An example of the latter is shown below: 
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  Statistics window. The Statistics window contains information about the 
“Fit.” Notice that information about the estimated value for cadralazine 
clearance and the other noncompartmental parameters in this patient are 
available under “Derived Variables” in the Parameter/Variable pane. 

 
 
Part 6. Save the results of the Fit to Notes. 

 
1. In the Statistics window, in the Parameter/Variable pane, select the parameters 

and derived variables. 
 
2. In the Edit menu, click Copy. 
 
3. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar, click 

Notes . The Notes window will open. 
 
 4. In the Notes window, type “Best fit of a one-compartment model to data. 

Noncompartmental parameters estimated.” 
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5. In the Edit menu, click Paste. The statistical information will be pasted into the 
Notes window, which will appear as follows: 
 

 
 
 

  Notes. The Notes window allows you to keep track of what you did during 
your modeling exercise. If you save the study file, the notes are saved as part 
of the file so you can return to them when you run the study file at a later 
time. 

 
 

6. Close the Notes, Statistics and Plot windows. 
 
You may save your study file if you wish for future use. This can serve as a template for 
any analysis you may wish to do involving a one-compartment model with a bolus 
injection of drug. 
 
Quit the SAAM II Compartmental application. 
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Modeling Notes: 
 
What is the relationship between CL, k(0,1) and V1? Remember that the differential 
equation for the one-compartment model is 
 

Dose1q)1,0(k
dt

1dq
+−=  

 
The solution to this equation is a single exponential function 
 

)t*)1,0(kexp(Dose1q −⋅=  
 

and the measurement sample s1 is thus 
 

)*)1,0(exp(
11

1
1 tk

V
Dose

V
q

s −==  

 
An alternative parameterization of this model is 
 

)*
1

exp(
11

11 t
V
Cl

V
Dose

V
qs −==  

 
because Cl = k(0,1) * V1. That is, both the parameter pairs (k(0,1), V1)  or (Cl, V1) 
alternatively define completely the one-compartment model. If you choose to use the 
second parameterization, you will have to open the Loss Attributes dialog box 
associated with k(0,1), and type the equation “k(0,1)=Cl/V1”. In the Parameters dialog 
box, k(0,1) will no longer appear on the parameter list since it has been defined by an 
equation. The parameter that will appear is clearance, Cl. 
 
Essential Points to Remember 
 

• Derived variables (noncompartmental parameters) can be defined in your 
model. 

• The Notes window provides a convenient way to keep track of your modeling 
exercise. 

• Your model can be re-parameterized in terms of volume and clearance. 
• This model can serve as a template for any drug study where the drug was 

administered as a bolus, and the decay was monoexponential. 
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 Appendix: Obtaining Initial Parameter Estimates 
for the One-Compartment Model (One-Exponential Model) 

 
  
The key to understanding how initial parameter estimates can be obtained for the one-
compartment (or one-exponential) model lies in understanding the notion of half-life 
(sometimes called the half-time). The half-life is defined as the time it takes for one-half 
of the material remaining in a system to irreversibly leave the system. The reason why 
this works so well in the one-compartment case is that the data, when plotted semi-
logarithmically, appear as a straight line. Thus, as will be seen, one can pick an arbitrary 
point on this line, and one half of this material represented by this point will appear on 
the line as a time equal to the “half-life” later. 
 
In this appendix, you will learn how to obtain the initial estimates in the following two 
situations: 
 
• bolus injection of drug into plasma, and serial plasma samples taken; and 
• constant infusion of drug into plasma, and serial plasma samples taken. 
 
The bolus injection will be discussed first since, when plotted semilogarithmically, the 
data appear as a straight line. This is not the case with the constant infusion. 
 
 Bolus injection into plasma 
 
If you plot the cadralazine data in semi-log form, you will obtain the following: 
 

©University of Washington Cad - 25 Rev. 08/10/01 



Pharmacokinetic Case Study Cadralazine Kinetics 

 
 

The data appear to lie on a straight line. Why? 
 
The answer comes from the fact that for the one-compartment (monoexponential) model, 
the semi-logarithmic transformation results in a linear plot. This can be explained as 
follows:  
 
Suppose you write the monoexponential decay 
 
  (1) tAety ⋅−= α)(
 
Taking the log of both sides of (1), you will have 
 
 tAty ⋅−= α)ln())(ln(  (2) 
 
This is a straight line whose slope is -α and whose intercept with the y-axis is ln(A). 
 
How can one find α and A? 
 
The first thing you do is to draw a straight line through the data (as shown in the figure 
below). Where the line intersects the y axis will provide an estimate for A. This is shown 
graphically in the following figure. 
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To find an estimate for α, pick an arbitrary point on the line shown above; say this occurs 
at time t* (in the above, the arbitrary point’s y-axis value is 1 and t* is about 2.8 hours). 
Then the value of y(t) defined in (1) is 
 

  (3) 
*

)( * tAety ⋅−= α

 
One-half of this material (which in the above would be 0.5) is 
 

 
*

22
)( *

taeAty ⋅−=  (4) 

 
Write t1/2 for the time of the half-life, i.e. the time it takes for one half of the material in 
the system to irreversibly leave the system. Then from (3), the amount of material in the 
system is given by 
 

  (5) )(
2/1

* 2/1
*

)( ttAetty +÷−=+ α

 
Equating (4) and (5) 
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)( 2/1

**

2
ttt AeeA +⋅−⋅− = αα

 (6) 

 
Rewriting (6) 
 

 2/1

2
1 te ⋅−= α

 (7) 

 
It is important to notice that both A and no longer appear in the equation. The only 
terms remaining are α and t

*te ⋅−α

1/2. Equation (7) can be rewritten to express the relationship 
between α and t1/2
 

 
2/12/1

693.0)2ln(
tt

≈=α  (8) 

 
These steps are illustrated in the previous figure reproduced below for convenience:  
 

 
  
In this figure, the intercept with the y-axis is 1.7. To estimate the half-life, you can start 
with 1.0 (written 100 in the figure) as indicated. This occurs at about 2.8 hours as 
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indicated by the dashed line intersecting the x-axis at 2.8 hours. Half of 1.0 is 0.5; this 
occurs at about 6.2 hours again as indicated by the dashed line intersecting the x-axis at 
6.2 hours. Thus the half-life is 6.2 - 2.8 or 3.4 hours. An estimate for α can be obtained 
from ln(2)/3.4 which is about 0.20. 
 
If you are fitting the monoexponential (3) to the data, then 1.7 and 0.2 would provide 
initial estimates for A and α, and you can proceed to fit the model to the data. What 
happens in the case of the one-compartment model is the following: 
 
Your one-compartment model represents the differential equation 
 

 Dqqk
dt

dq
=⋅−= )0(11)1,0(1  (9) 

 
where, in this equation, D is the dose of the drug given as a bolus. The solution to this 
equation is 
 
  (10) tkeDtq ⋅−⋅= )1,0()(1
 
However, the data are concentration, not mass, and the measurement equation is thus 
 

 tke
V
Ds ⋅−⋅= )1,0(

1
1  (11) 

 
Compare (1) and (11). The equations y(t) and s1 describe the same set of data; one is the 
exponential model and the other the solution of the differential equation. Since the 
exponentials must be the same, one has immediately that an estimate for k(0,1) is α. Also, 
A equals D/V1. Thus an estimate for the volume of the compartment V1, is D/A. It is 
absolutely essential to know that, to estimate the volume of the compartment, you must 
know the dose. If you do not know the dose, you cannot estimate the volume. 
 
For this example, an estimate for k(0,1) is 0.2. The dose was 30mg, and the units of the 
data are mg/L. An estimate for A is 1.7, so the estimate for V1 is D/A, 30/1.7, which is 
about 17L. 
 
Summarizing, the steps in obtaining the initial estimates for the one-compartment model 
are as follows: 
 
• Plot the data on semi-log paper to see whether or not they lie on a straight line. 
• Draw a straight line through the data; extend the line to intersect with the y-axis. 
• Calculate the half-life t1/2 as described above. 
• Note where the line intersects the y-axis. 
• Estimate the volume and k(0,1) (or A and α) as described above. 
 
 Constant infusion into plasma 
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The case when the drug is administered as a constant infusion into plasma represented by 
a one- compartment model is not as straightforward as the bolus injection. The reason is 
that the semi-logarithmic transformation does not result in a linear plot. This is easily 
seen when you realize that the equation for a single exponential rise is 
 
  (12) )1()( teAty ⋅−−⋅= α

 
If, as in (3), you take the logarithm of both sides of (12), the right hand side does not 
collapse into the equation for a straight line! 
 
If you examine (12) more closely, you will see that y(0) equals 0 which, in the case of the 
constant infusion, it should. In addition, A is the plateau value since for large values of t, 
the exponential term is close to zero. Thus for the rising data, an estimate for A can be 
obtained by estimating the plateau value of your data. 
 
The other important observation to make is that if you subtract A from (12), you will have 
 
  (13) teAty ⋅−⋅−= α)(*

 
which is a monoexponential the negative of which is monoexponentially decaying. Thus 
the hint on how to obtain the initial estimate for α for the monoexponentially rising data 
is the following: if you transform your data by first subtracting A from them, and then 
multiplying by -1, the initial data will decay exponentially, and you can use the above to 
estimate α. 
 
Consider the following example of a set of data. These data were obtained following an 
infusion of 500,000 units/min into plasma. You cannot really tell from looking at them 
whether they rise monoexponentially or biexponentially. However, you should always 
start with the one exponential (one-compartment) model. 
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These data are plotted semi-logarithmically, and it is clear, unlike the first case, they do 
not lie on a straight line. However, as shown below, an estimate for the plateau value of 
3400 can easily be obtained: 
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Intercept = 3400

 
 

The plateau value can be subtracted from the actual data and multiplied by -1; this is 
shown in the following: 
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t plasma data-3400 -(DATA-3400)
3 473 -2927.00 2927.00
6 915 -2485.00 2485.00
9 1127 -2273.00 2273.00
12 1549 -1851.00 1851.00
15 1840 -1560.00 1560.00
20 2229 -1171.00 1171.00
30 2817 -583.00 583.00
40 3111 -289.00 289.00
50 3223 -177.00 177.00
60 3399 -1.00 1.00
70 3241 -159.00 159.00
80 3128 -272.00 272.00
90 3169 -231.00 231.00
100 3337 -63.00 63.00
110 3546 146.00 -146.00
120 3281 -119.00 119.00
130 3223 -177.00 177.00
140 3543 143.00 -143.00
150 3624 224.00 -224.00  

 
If you plot -(DATA-3400), you will obtain the following: 
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Two important observations need to be made. First, the “noise” in the data after 50 
minutes is due to the fact the data are on the plateau. Second, as the plateau is reached 
there appears to be curvature in the “decay.” Thus the best estimates for the initial decay 
will come from the earlier time points. When drawing the line through the data, these 
points should have more influence. This is shown below: 
 

Intercept = 3400

 
 
There are some additional things to notice in the above plot. First, the straight line 
intersects the y-axis at about 3400; this is as would be predicted. Second, the line through 
the initial “data” had to be extended in order to obtain the half-life estimate. The half-life 
is calculated by starting from 2000 (the y-axis value), which occurs at 6 minutes, and 
ending at 1000 (the y-axis value), which occurs at 18 minutes. The half-life is thus 12 
minutes, and an estimate for α can be obtained from ln(2)/12 which is about 0.06. 
 
Thus if you are working with the monoexponential rise model, equation (12), your initial 
estimates for A and α would be 3400 and 0.06 respectively. What about the one-
compartment model? You need estimates for the volume, V1, and the rate constant k(0,1). 
As with the previous case, an estimate for k(0,1) is α. The problem, then, is to estimate 
the volume. 

©University of Washington Cad - 34 Rev. 08/10/01 



Pharmacokinetic Case Study Cadralazine Kinetics 

 
To estimate the volume requires some knowledge of estimating the noncompartmental 
parameters. It is known that the clearance rate, Cl, can be estimated as the quotient of the 
infusion rate and plateau value. In this case, the infusion rate is 500,000 units/min and the 
plateau is 3400. Thus 
 

 147
3400

500000
===

Plateau
rateInfusionCl  (14) 

 
But the clearance rate is also the product of the volume and k(0,1). That is, if V1 is the 
volume of the compartment,  
 
 1)1,0( VkCl ⋅=  (15) 
 
Knowing that the estimate for k(0,1) is 0.06 and the estimate for Cl is 147, an estimate for 
V1 of 2450 can be obtained. 
 
Summarizing: The steps in obtaining the initial estimates for the one-compartment model 
following a constant infusion are as follows: 
 
• Plot the data on semi-log paper. 
• Estimate the plateau value (which is A in the monoexponential model) 
• Subtract the plateau value from each datum, and multiply the result by -1. 
• Plot the modified data on semi-log paper.  
• Draw a straight line through the initial decaying data (it should intersect at 

approximately your estimate of the plateau value. 
• Calculate the half-life along the line, and estimate k(0,1) (or a) as described above. 
• Estimate the volume as described above by first estimating the clearance rate, and 

then the volume. 
 
Question: is there a quicker way to estimate α or k(0,1)?  That is, do I always have to 
calculate the “modified” data? The answer is yes, there is a quicker way, but the estimate 
is not as robust as the above, and may require some hand-fitting before proceeding. 
 
The idea is the following. You can estimate the time it takes for the data to rise half way 
to the plateau. In this case, the plateau value is 3400, so half way is 1700. As indicated on 
the following figure, the time, the half-life, to go from zero to 1700 is approximately 13 
minutes. Using the relationship between the half-life and α, one can estimate α, or k(0,1), 
as ln(2)/13 which is approximately 0.053. This is close to the estimate obtained above, 
and is clearly sufficient as a starting point.  
 
The situation is shown in the following figure: 
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Thus it is safer to use the first method in the case of the constant infusion. However, this 
method is much quicker and while it may require some hand-fitting to adjust the 
estimates, it is usually close enough that you can proceed with fitting your model to your 
data. 
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Data for this case study 
 
This data file also contains the equations for the noncompartmental parameters. 
 
DATA 
#Data used for Cadralazine Case Study 
#Cadralazine1 from Wakefield et al., Applied Statistics, 43(1): 201-221, 1994. 
# The dose for this study was 30 mg 
(FSD 0.1) 
t plasma 
0 n 
2 1.09 
4 0.75 
6 0.53 
8 0.34 
10 0.23 
24 0.02 
END 
CONST Dose 30 
# 
#  Equations for the noncompartmental parameters 
# 
#Cl=k(0,1)*V1 
#Cmax = Dose/V1 
#t_half = log(2)/k(0,1) 
#AUC = Dose/(V1*k(0,1)) 
#AUMC = Dose/(V1*k(0,1)*k(0,1)) 
#MRT_syst = AUMC/AUC 
#MRT_plasma=1/k(0,1) 
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